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                                         Experiment 01 Objective: To study input/output devices. Introduction  The computer will be of no use unless it is able to communicate with the outside world. Input/Output devices are required for users to communicate with the computer. In simple terms, input devices bring information INTO the computer and output devices bring information OUT of a computer system. These input/output devices are also known as peripherals since they surround the CPU and memory of a computer system.      Input Devices  (a) Keyboard  It is a text base input device that allows the user to input alphabets, numbers and other characters. It consists of a set of keys mounted on a board. Alphanumeric Keypad  It consists of keys for English alphabets, 0 to 9 numbers, and special characters like + − / * ( ) etc.  Function Keys  There are twelve function keys labeled F1, F2, F3… F12. The functions assigned to these keys differ from one software package to another. These keys are also user programmable keys.  Special-function Keys  These keys have special functions assigned to them and can be used only for those specific purposes. Functions of some of the important keys are defined below.  Enter  It is similar to the ‘return’ key of the typewriter and is used to execute a command or program.  Spacebar  It is used to enter a space at the current cursor location.  Backspace  This key is used to move the cursor one position to the left and also delete the character in that position.  Delete  It is used to delete the character at the cursor position.  Insert  Insert key is used to toggle between insert and overwrite mode during data entry.  Shift  
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This key is used to type capital letters when pressed along with an alphabet key. Also used to type the special characters located on the upper-side of a key that has two characters defined on the same key.  Caps Lock  Cap Lock is used to toggle between the capital lock features. When ‘on’, it locks the alphanumeric keypad for capital letters input only.  Tab  Tab is used to move the cursor to the next tab position defined in the document. Also, it is used to insert indentation into a document.  Ctrl Control key is used in conjunction with other keys to provide additional functionality on the keyboard.  Alt  Also like the control key, Alt key is always used in combination with other keys to perform specific tasks.  Esc  This key is usually used to negate a command. Also used to cancel or abort executing programs.  Numeric Keypad  Numeric keypad is located on the right side of the keyboard and consists of keys having numbers (0 to 9) and mathematical operators (+ − * /) defined on them. This keypad is provided to support quick entry for numeric data.  Cursor Movement Keys  These are arrow keys and are used to move the cursor in the direction indicated by the arrow (up, down, left, right).   (b) Mouse   The mouse is a small device used to point to a particular place on the screen and select in order to perform one or more actions. It can be used to select menu commands, size windows, start programs etc. The most conventional kind of mouse has two buttons on top: the left one being used most frequently.  Mouse Actions  Left Click : Used to select an item.  Double Click : Used to start a program or open a file.  Right Click : Usually used to display a set of commands.  Drag and Drop : It allows you to select and move an item from one location to another.  To achieve this place the cursor over an item on the screen, click the left mouse button and while holding the button down move the cursor to where you want to place the item, and then release it.  (c) Joystick    
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The joystick is a vertical stick which moves the graphic cursor in a direction the stick is moved. It typically has a button on top that is used to select the option pointed by the cursor. Joystick is used as an input device primarily used with video games, training simulators and controlling robots (d)Scanner  Scanner is an input device used for direct data entry from the source document into the computer system. It converts the document image into digital form so that it can be fed into the computer. Capturing information like this reduces the possibility of errors typically experienced during large data entry. Hand-held scanners are commonly seen in big stores to scan codes and price information for each of the items. They are also termed the bar code readers. (d) Bar codes  A bar code is a set of lines of different thicknesses that represent a number. Bar Code Readers are used to input data from bar codes. Most products in shops have bar codes on them.Bar code readers work by shining a beam of light on the lines that make up the bar code and detecting the amount of light that is reflected back (e) Light Pen  It is a pen shaped device used to select objects on a display screen. It is quite like the mouse (in its functionality) but uses a light pen to move the pointer and select any object on the screen by pointing to the object. Users of Computer Aided Design (CAD) applications commonly use the light pens to directly draw on screen.  (f) Touch Screen  It allows the user to operate/make selections by simply touching the display screen. Common examples of touch screen include information kiosks, and bank ATMs.         (h)Digital camera            A digital camera can store many more pictures than an ordinary camera. Pictures taken                         using a digital camera are stored inside its memory and can be transferred to a computer by connecting the camera to it. A digital camera takes pictures by converting the light passing through the lens at the front into a digital image.                     (i)The Speech Input Device                    The “Microphones - Speech Recognition” is a speech Input device. To operate it we require                     using a microphone to talk to the computer. Also we need to add a sound card to the computer. The Sound card digitizes audio input into 0/1s .A speech recognition program can process the input and convert it into machine-recognized commands or input. Output Devices  
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(a) Monitor  Monitor is an output device that resembles the television screen and uses a Cathode Ray Tube (CRT) to display information. The monitor is associated with a keyboard for manual input of characters and displays the information as it is keyed in. It also displays the program or application output. Like the television, monitors are also available in different sizes.  (b) Liquid Crystal Display (LCD)  LCD was introduced in the 1970s and is now applied to display terminals also. Its advantages like low energy consumption, smaller and lighter have paved its way for usage in portable computers (laptops). (c) Printer  Printers are used to produce paper (commonly known as hardcopy) output. Based on the technology used, they can be classified as Impact or Non-impact printers. Impact printers use the typewriting printing mechanism wherein a hammer strikes the paper through a ribbon in order to produce output. Dot-matrix and Character printers fall under this category. Non-impact printers do not touch the paper while printing. They use chemical, heat or electrical signals to etch the symbols on paper. Inkjet, Deskjet, Laser, Thermal printers fall under this category of printers. When we talk about printers we refer to two basic qualities associated with printers: resolution, and speed. Print resolution is measured in terms of number of dots per inch (dpi). Print speed is measured in terms of number of characters printed in a unit of time and is represented as characters-per-second (cps), lines-per-minute (lpm), or pages-per-minute (ppm) (d) Plotter  Plotters are used to print graphical output on paper. It interprets computer commands and makes line drawings on paper using multicolored automated pens. It is capable of producing graphs, drawings, charts, maps etc. Computer Aided Engineering (CAE) applications like CAD (Computer Aided Design) and CAM (Computer Aided Manufacturing) are typical usage areas for plotters. (e) Audio Output:  Sound Cards and Speakers: The Audio output is the ability of the computer to output sound. Two components are needed: Sound card – Plays contents of digitized recordings, Speakers – Attached to sound card.       
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                                         Experiment 02 OBJECTIVE:STUDY OF STORAGE DEVICE Storage Devices are the data storage devices that are used in the computers to store the data. The computer has many types of data storage devices. Some of them can be classified as the removable data Storage Devices and the others as the non removable data Storage Devices.  The memory is of two types; one is the primary memory and the other one is the secondary memory.  The primary memory is the volatile memory and the secondary memory is the non volatile memory. The volatile memory is the kind of the memory that is erasable and the non volatile memory is the one where in the contents cannot be erased. Basically when we talk about the data storage devices it is generally assumed to be the secondary memory.  The secondary memory is used to store the data permanently in the computer. The secondary storage devices are usually as follows: hard disk drives – this is the most common type of storage device that is used in almost all the computer systems. The other ones include the floppy disk drives, the CD ROM, and the DVD ROM. The flash memory, the USB data card etc. Find out more ... Navigate through the list of storage devices given on the right side.    Floppy discs A floppy disk is a data storage medium that is composed of a disk of thin, flexible floppy)magnetic storagemedium encased in asquareor rectangularplasticshell. Floppy disks are read and written by afloppy disk drive.  Application Any use where small files such as word processing, small spreadsheets and databases need to be moved from one computer to another. Useful to backup small data files.  Fixed hard discs 
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A hard disk drive is the device used to store large amounts of digital information in computers and related equipment like iPods and games consoles such as the Xbox 360 and PS3. Hard disk drives are used to store operating systems, software and working data.  These are suitable for any application which requires very fast access to data for both reading and writing to. However, Hard disk drives may not be suitable for applications which need portability.  Almost all computers used a fixed hard disc. Used for on-line and real time processes requiring direct access. Used in file servers for computer networks to store large amount of data.   Portable hard discs Portable hard discs are good fun because you can carry data about all over the place and transfer information, programs, pictures, etc between computers.  Advantages: 
 Greatly improved data cargo carrying capacity (relative to the 1.44 Mb floppy disc). 
 You don't need to worry about the other person having the same type of special cartridge drive as yourself. Disadvantages: 
 Hard drives have to be handled quite carefully, and when being transported should be wrapped in something soft and put in a padded bag. 
 More expensive than other forms of removable media. 
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Application Portable disc discs are used to store very large files which need transporting from one computer to another and price is not an issue.  Magnetic tapes Magnetic tape has been used for data storage for over 50 years. When storing large amounts of data, tape can be substantially less expensive than disk or other data storage options. Tape storage has always been used with large computer systems. Modern usage is primarily as a high capacity medium for backups and archives.    Drawbacks Writing and retrieving data is slow. It uses serial access for reading and writing. Application Magnetic tapes are used for application which requires extremely large storage capacity where speed of access is not an issue.  It is commonly used for backups of file servers for computer networks, in a variety of batch processing applications such as reading of bank cheques, payroll processing and general stock control. 
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  Optical backing storage media such as CDs andDVDs  

 CDs tend to be used for large files (but smaller than 1Gb) which are too big for a floppy disc to hold such as music and general animation. 
 DVDs are used to hold very large files (several Gb) such as movie films. Both CDs and DVDs are portable i.e. they can be transported from one computer to another. Both can be used to store computer data. 
 CD ROM/DVD ROM Applications which require the prevention of deletion of data, accidental or otherwise. CDs used by software companies for distributing software programs and data; by Music companies for distributing music albums and by book publishers for distributing encyclopaedias, reference books etc. DVDs used by film distributors. 
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 CD R/DVD R Applications which require a single ‘burning’ of data, e.g. CDs - recording of music downloads from the Internet, recording of music from MP3 format, recording of data for archiving or backup purposes. DVDs – recording of film movies and television programs. 
 CD RW/DVD RW Applications which require the updating of information and ability to record over old data. Not suitable for music recording but is very useful for keeping generations of files. DVDs have between five and ten times the capacity of CDs.  Solid state backing storage 
 These are the smallest form of memory available in the market today. 
 Widely used as removable storage. 
 They are more robust than other forms of storage. 
 Though expensive than other forms they can be easily written to and updated. Memory sticks/Pen drives  USB flash drives are typically removable and rewritable, much smaller than a floppy disk. Storage capacities typically range from 64 MB to 64 GB. USB flash drives offer potential advantages over other portable storage devices, particularly the floppy disk.  They have a more compact shape, operate faster, hold much more data, have a more durable design, and operate more reliably due to their lack of moving parts. Flash drives are widely used to transport files and backup data from computer to computer. Flash memory cards  A memory card or flash memory card is a solid-state electronic flash memory data storage device used with digital cameras, handheld and Mobile computers, telephones, music players, video game consoles, and other 
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electronics.  Nowadays, most new PCs have built-in slots for a variety of memory cards; Memory Stick, CompactFlash, SD, etc. Some digital gadgets support more than one memory card to ensure compatibility.                                                                                 EXPERIMENT03 Lab Objectives:  1) To become familiar with basics of Microsoft Word 2007 2) To become familiar with the online help facilities of Word 2007.   Online resource:  An excellent online tutorial resource on Microsoft Word 2007 can be viewed at http://www.fgcu.edu/support/office2007/Word/.   Layout of Microsoft Word 2007:  
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  The Microsoft Office Button This button allows you to create a new document, open an existing document, save or save as, print, send (through email or fax), publish or close.  The Ribbon   The Ribbon is the panel at the top portion of the document. It has seven tabs: Home, Insert, Page Layout, References, Mailings, Review, and View that contain many new and existing features of Word. Each tab is divided into groups. The groups are logical collections of features designed to perform functions that you will utilize in developing or editing your Word document. Commonly used features are displayed on the Ribbon, to view additional features within each group, click on the arrow at the bottom right of each group. Quick Access Toolbar 
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 The quick access toolbar is a customizable toolbar that contains commands that you may want to use. You can place the quick access toolbar above or below the ribbon.   Lab exercise:  1) Opening and saving files    a. Open a new file and save it while saving the file’s name as ‘your first name’-lab-3.docx. For example, a student name Abdullah should save the file as Abdullah-lab3.docx.  [Hint: The functionality to open and save a new file is available by clicking on the Microsoft Office button     ]  b. Find out the shortcuts for opening and saving a file.  2) Word formatting exercises:  
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  Type the following sentence into your newly created Word file.  “I, (write your own name here), am a student of BEE5-(write your section name here) at the School of Electrical Engineering and Computer Science.”   Changing the formatting of typed text:  a. Italicizing text: Copy/ paste the original sentence above and now precede the statement with the text “Italicized copy: “. Italicize the whole text.  b. Making text bold: Copy/ paste the original sentence and now precede the statement with the text “bold text copy: “. Change the type of your name, your section, and school’s name to bold.   c. Underlining text: Copy/ paste the original sentence and now precede the statement with the text “Underline text: “. Underline your name, your section, and school’s name.   d. Crossing out text: Copy/ paste the original sentence and now precede the statement with the text “Crossed out text copy: “.Cross out your name, your section, and school’s name.  e. Text in different fonts: Copy/ and paste the original sentence twice (2 new copies). For the first copy, change the font of the sentence to Tahoma, and for the second copy change the font of the sentence to Verdana. Write the font names in brackets at the end of each copied statement.  f. Text in different font sizes: Copy/ and paste the original sentence twice (2 new copies). For the first copy, change the font size of the sentence to 14, and for the second copy, change the font size to 16. Write the font sizes in brackets at the end of each copied statement.  g. Text in different colors: Copy/ and paste the original sentence twice (2 new copies). For the first copy, change the text color to red, and for the second copy, change the text color to blue.     The solution to this exercise should look like the following for a student named Abdullah.  
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   3) Finding and replacing text: In the file that you have created, find the text ‘School of Electrical Engineering and Computer Science’ and replace it with the text ‘School of Electrical Engineering and Computer Science (SEECS) at the National University of Sciences and Technology (NUST)’   The output of this step should look like the following:  
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 4) Undoing and Redoing changes: How can changes made to a document be undone? How can changes undone be redone? (Hint: look in the quick access toolbar)   a. Undo the changes to the file in Q 3) and revert to the form in Q 2).  5) Inserting URL/ shapes/ symbols/ headers/ footers:  (Hint: Look for the Insert tab in the tabs of ribbon)  a. How can a URL link be inserted? In the open file, insert a link to the URL: http://www.niit.edu.pk/~junaid.qadir/  (hint: look in insert hyperlink)  b. Insert the arrow shape that follows (hint: look in insert shapes)    c. Insert the following symbol α (hint: look in insert symbols)  d. Insert a header and footer in your file. (hint: look in insert header and insert footer)  6) Making a list:  Make a list of all the subjects that you are studying. For example, your generated list should look like:  1) Physics 2) Fundamentals of ICT 3) Communication Skills 4) ECA  a. Make the numbering of the list bold  b. Change the color of the numbering of the list  c. Change the listing identifiers from 1), 2), 3) to i), ii) and iii).  7) Making a table:  Make a table with three columns and three rows. Also color the top row gray. Your table should look like the following.  Row1 Row1 Row1 Column1 Column2 Column3 Column1 Column2 Column3  8) Checking Spellings and Grammar  Check the document you have created for any spelling and/ or grammar error. (Hint: Go to the Review tab in the tabs on the ribbon, and click on Spelling & Grammar)  9) Calculating the word count  Calculate the total word count of your document. (Hint: Click on the Review tab and then on Spelling & Grammar) 
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 10) Commenting on a document  Use the Review > New Comment option to select a text and then comment on it. The comments are not part of the original document, and are used to foster collaboration/ better understanding of the text.                        
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 EXPERIMENT 04 Lab Objectives:  1) To become familiar with basics of Microsoft Excel 2007 2) To become familiar with the online help facilities of Excel 2007.   Excel Basics:  Microsoft Excel is a spreadsheet application. Spreadsheets are ways to organize data by grouping it into rows and columns.   Basic terminology:  Cell: the small boxes where data exists in a spreadsheet. Cells are identified by the column number followed by the row number. Columns are named by letters A-Z, followed by A(A-Z), B(A-Z) and so forth, whereas rows are numbered by numbers 1, 2, and so on.  Online resource:  http://tiny.cc/excel   Lab exercise:  Part I---Generating and formatting spreadsheet  Open a new file and save it as an excel workbook naming it `your-name’.  1) Explore the number formatting options in Excel. Enter some number in any cell, and then change the number formatting to: a. Percentage b. Currency     2) Enter the date of the day you are doing this lab exercise. If the date is 30th January, 2009, write 1/30/2009. Change the formatting of the date by right clicking on the cell and choosing “Format Cells”. Alternatively, click on the arrow in the Numbers tab as shown in the figure below:   
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   a. List some other ways dates can be formatted automatically in Excel?  3) Explore the alignment and font options in Excel that can be used for formatting cells. More options can be seen by clicking on the arrows beneath the alignment and font options as shown in the figure below.     a. List down three alignment options. b. List down three font options   Part II---Using automatic features of Microsoft Excel 2007  Consult the webpage: http://www.internet4classrooms.com/excel_auto_edit.htm for the following exercise  1) Suppose you would like to create a column for each month of the year (as shown in the following figure). How can you achieve this without manually writing the name of each month?     Click here for font and alignment options, respectively  

  Number formatting options 
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  Hint: you would need to paste the contents of the first column till the twelfth column when the cursor shape is like     2) Suppose that the data that you want to enter in successive columns of the first row is an arithmetic series. Let’s suppose the series is 1, 2, 3, till 100.   a. How can you enter all these numbers automatically?   Hint: you would need to paste the contents of the first column till the 100th twelfth column when the cursor shape is like   b. How can the sum of all the numbers added be obtained?  Hint: You can use the autosum feature present in Excel.  3) Suppose that you would like to enter student 1 in the first row of the first column, and student 10 in the 10th row of the first column. How can you do this automatically?  Hint: you would need to paste the contents of the first row of the first column till the 10th row of the first column when the cursor shape is like     Part III---Sorting and top/ bottom rules  For this exercise, we will use your class’ award list (complete till mid-semester results); students should download the companion file for their respective shown from the course website.   1) Sort the students according to their current standing in the class. The top student shall be on top. Note down your position in the class.   Hint: You can use the Sort and Filter option in the editing tab.  
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  2) Now sort the students from lowest to highest such that the student getting the lowest marks will be highest. Note down your position in the class.    3) Determine if you are in the top 10% of the class. Also note down how many students are there in the top 10%  Hint: You will use the conditional formatting option for this. (Conditional formatting > Top/ bottom rules > top 10%.)  
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    4) Sort the students now in alphabetical order. Note down what number your name is now?  Part IV---Functions  You will continue to use your class section’s award list in this part.  1) Determine your class average?  Hint: Look for the average function in the functions tab  
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  2) Using the max function, determine the maximum marks scored by any student    3) Using the min function, determine the minimum marks obtained by any student 
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  4) In the cell A60, determine the difference between the maximum marks and the minimum marks.   Hint: Select the cell A60, and enter =max(b1:b54)-min(b1:b54) [assuming that there are 54 students in your class section, check the number of students in your class for the correct formula]   Part V---Charting  Hint: Insert > Chart  Sort the student marks from the largest to the smallest.   1) Draw a scatter plot of the student’s marks.   

  2) Note down all the options in the Chart options (visible when the chart created is selected)  Student names here … … … 
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25.0030.0035.0040.0045.0050.00
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                                                                 EXPERIMENT 05 Lab Objectives:  1) To become familiar with basics of computer networking 2) To become familiar with basic TCP/IP configuration  Preamble:  You can read about some TCP/IP basics at http://en.wikipedia.org/wiki/TCP/IP   Lab exercise:  h. Noting down the TCP/IP configuration of your machine:  To check the TCP/IP configuration, double click on the LAN icon on your taskbar (two small monitors on the right hand side of your taskbar that look like ). Next, click on the Support tab of the window.   
  You will get a window similar to that shown next.     
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  a. What is the IP address of the machine you are working?  b. What is the subnet mask?  c. Note down the IP address of the default gateway. Is the default gateway on the same LAN as the machine? Explain why or why not?  (Hint: see if the network portion of the IP addresses match; hint 2: to find the network portion, use the subnet mask as taught in the class)  i. In the windows shown above, click on details. You will get a window similar to the next figure.  
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  a. What is the physical address or MAC address of the machine?  b. Can you configure the MAC address of the machine?  c. What is the name of the DNS server?  j. To examine the working of DNS, we will use a utility called nslookup. To use nslookup, open a command prompt (Click on the start menu, and then on Programs > Accessory > Command Prompt) and enter the command nslookup. Alternatively, you can use the run option on the start menu to enter nslookup.   
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  a. What is name of default DNS server for your machine? What is the IP address of the default DNS server?  b. Resolve the address www.google.com; do you get the same IPs as above?  c. Resolve the address www.niit.edu.pk  d. Resolve the address hpc.niit.edu.pk    Next week’s lab: Introduction to Microsoft Word           
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                                                                            EXPERIMENT 06 OBJECTIVE: STUDY OF MOTHERBOARD The main printed circuit board in a computer is known as the motherboard. Other names for this central computer unit are system board, main board, or printed wired board (PWB). The motherboard is sometimes shortened to Mobo. Numerous major components, crucial for the functioning of the computer, are attached to the motherboard. These include the processor, memory, and expansion slots. The motherboard connects directly or indirectly to every part of the PC. The type of motherboard installed in a PC has a great effect on a computer's system speed and expansion capabilities. Major Motherboard Components and Their Functions  A labeled ASRock K7VT4A Pro Mainboard. | Source Central Processing Unit (CPU) Also known as the microprocessor or the processor, the CPU is the computer's brain. It is responsible for fetching, decoding, and executing program instructions as well as performing mathematical and logical calculations. 
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The processor chip is identified by the processor type and the manufacturer. This information is usually inscribed on the chip itself. For example, Intel 386, Advanced Micro Devices (AMD) 386, Cyrix 486, Pentium MMX, Intel Core 2Duo, or iCore7. If the processor chip is not on the motherboard, you can identify the processor socket as socket 1 to Socket 8, LGA 775 among others. This can help you identify the processor that fits in the socket. For example, a 486DX processor fits into Socket 3. Random Access Memory (RAM) Random Access Memory, or RAM, usually refers to computer chips that temporarily store dynamic data to enhance computer performance while you are working. In other words, it is the working place of your computer, where active programs and data are loaded so that any time time the processor requires them, it doesn't have to fetch them from the hard disk. Random access memory is volatile, meaning it loses its contents once power is turned off. This is different from non-volatile memory, such as hard disks and flash memory, which do not require a power source to retain data. When a computer shuts down properly, all data located in RAM is returned back to permanent storage on the hard drive or flash drive. At the next boot-up, RAM begins to fill with programs automatically loaded at startup, a process called booting. Later on, the user opens other files and programs that are still loaded in the memory. Basic Input/Output System (BIOS) BIOS stands for Basic Input/Output System. BIOS is a "read only" memory, which consists of low-level software that controls the system hardware and acts as an interface between the operating system and the hardware. Most people know the term BIOS by another name—device drivers, or just drivers. BIOS is essentially the link between the computer hardware and software in a system. All motherboards include a small block of Read Only Memory (ROM) which is separate from the main system memory used for loading and running software. On PCs, the BIOS contains all the code required to control the keyboard, display screen, disk drives, serial communications, and a number of miscellaneous functions. The system BIOS is a ROM chip on the motherboard used during the startup routine (boot process) to check out the system and prepare to run the hardware. The BIOS is stored on a ROM chip because ROM retains information even when no power is being supplied to the computer. Complimentary Metal Oxide Semiconductor Random Access Memory (CMOS RAM)  A CMOS battery. Motherboards also include a small separate block of memory made from CMOS RAM chips which is kept alive by a battery (known as a CMOS battery) even when the PC’s power is off. This prevents reconfiguration when the PC is powered on. CMOS devices require very little power to operate. 
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The CMOS RAM is used to store basic Information about the PC’s configuration for instance:- 
 Floppy disk and hard disk drive types 
 Information about CPU 
 RAM size 
 Date and time 
 Serial and parallel port information 
 Plug and Play information 
 Power Saving settings Other Important data kept in CMOS memory is the time and date, which is updated by a Real Time Clock (RTC). Cache Memory  L2 cache on an old motherboard. Cache memory is a small block of high-speed memory (RAM) that enhances PC performance by pre-loading information from the (relatively slow) main memory and passing it to the processor on demand. Most CPUs have an internal cache memory (built into the processor) which is referred to as Level 1 or primary cache memory. This can be supplemented by external cache memory fitted on the motherboard. This is the Level 2 or secondary cache. In modern computers, Levels 1 and 2 cache memory are built into the processor die. If a third cache is implemented outside the die, it is referred to as the Level 3 (L3) cache. Expansion Bus  PCI slots. An expansion bus is an input/output pathway from the CPU to peripheral devices and it is typically made up of a series of slots on the motherboard. Expansion boards (cards) plug into the bus. PCI is the most common expansion bus in a PC and other hardware platforms. Buses carry signals such as data, memory addresses, power, and control signals from component to component. Other types of buses include ISA and EISA. Expansion buses enhance the PCs capabilities by allowing users to add missing features in their computers by slotting adapter cards into expansion slots. Chipsets A chipset is a group of small circuits that coordinate the flow of data to and from a PC's key components. These key components include the CPU itself, the main memory, the secondary cache, and any devices situated on the buses. A chipset also controls data flow to and from hard disks and other devices connected to the IDE channels. 
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A computer has got two main chipsets: 
 The NorthBridge (also called the memory controller) is in charge of controlling transfers between the processor and the RAM, which is why it is located physically near the processor. It is sometimes called the GMCH, for Graphic and Memory Controller Hub. 
 The SouthBridge (also called the input/output controller or expansion controller) handles communications between slower peripheral devices. It is also called the ICH (I/O Controller Hub). The term "bridge" is generally used to designate a component which connects two buses. Chipset manufacturers include SIS, VIA, ALI, and OPTI. CPU Clock The CPU clock synchronizes the operation of all parts of the PC and provides the basic timing signal for the CPU. Using a quartz crystal, the CPU clock breathes life into the microprocessor by feeding it a constant flow of pulses. For example, a 200 MHz CPU receives 200 million pulses per second from the clock. A 2 GHz CPU gets two billion pulses per second. Similarly, in any communications device a clock may be used to synchronize the data pulses between sender and receiver.  A "real-time clock," also called the "system clock," keeps track of the time of day and makes this data available to the software. A "time-sharing clock" interrupts the CPU at regular intervals and allows the operating system to divide its time between active users and/or applications. Switches and Jumpers 
 DIP (Dual In-line Package) switches are small electronic switches found on the circuit board that can be turned on or off just like a normal switch. They are very small and so are usually flipped with a pointed object, such as the tip of a screwdriver, a bent paper clip, or a pen top. Take care when cleaning near DIP switches, as some solvents may destroy them. Dip switches are obsolete and you will not find them in modern systems. 
 Jumper pins are small protruding pins on the motherboard. A jumper cap or bridge is used to connect or short a pair of jumper pins. When the bridge is connected to any two pins, via a shorting link, it completes the circuit and a certain configuration has been achieved. 
 Jumper caps are metal bridges that close an electrical circuit. Typically, a jumper consists of a plastic plug that fits over a pair of protruding pins. Jumpers are sometimes used to configure expansion boards. By placing a jumper plug over a different set of pins, you can change a board's parameters.  


